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About This Guide

This Troubleshooting guide includes troubleshooting strategies for problems that may occur as you 
use ZENworks® for Desktops (ZfD) in your production environment.

The guide currently contains troubleshooting strategies that you can apply for the following ZfD3 
components:

Chapter 1, “Automatic Workstation Import,” on page 9

Chapter 2, “Workstation Management,” on page 13

Chapter 3, “Workstation Imaging,” on page 15

Chapter 4, “Remote Management,” on page 23

Chapter 5, “Workstation Inventory,” on page 27

Chapter A, “Documentation Updates,” on page 39

Documentation Updates

As administrators gain experience using ZfD, some unusual or previously untested 
implementation scenarios and undocumented product limitations will surface. We will gather this 
feedback from Novell customers and add it to this Troubleshooting guide as it becomes practical 
to do so.

We recommend that you visit the ZENworks for Desktops documentation Web site (http://
www.novell.com/documentation/lg/zfd3/docui/index.html) for the most current troubleshooting 
information.

Documentation Conventions

In Novell® documentation, a greater-than symbol (>) is used to separate actions within a step and 
items in a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.
About This Guide 7
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1 Automatic Workstation Import

This section contains information about the following:

“Troubleshooting Automatic Workstation Import” on page 9

Troubleshooting Automatic Workstation Import
The following sections provide troubleshooting information for ZENworks® for Desktops (ZfD) 
Automatic Workstation Import:

“A new Workstation object was created because the original object could not be found” on 
page 9

“Registration of Gateway clients fails” on page 9

“In Remote Management, the IPX address of the target workstation is not registering properly 
with NDS” on page 10

“Automatic Workstation Import does not work immediately after installation of ZfD” on page 
10

“Computer name changes are not being updated in the Workstation object” on page 10

A new Workstation object was created because the original object could not be found
Problem: When I either rename or move a Workstation object in Windows* 2000 or Windows NT*, the next 

time the workstation registers a new object gets created, instead of registering with the original 
object that I renamed or moved.

Possible Cause: Insufficient rights.

Explanation: The Workstation Import policy must have rights to the containers involved in renaming or moving 
a Workstation object.

Action: When you move or rename a Workstation object using Windows NT/2000, make sure the 
Workstation Import policy has rights in both the source and destination containers. This is most 
easily accomplished by adding these containers to the Containers list in the Workstation Import 
policy.

Registration of Gateway clients fails
Explanation: The Workstation Import policy can be configured so that no user information is required. This 

allows workstation registration to occur without user login. However, IP–IP or IPX–IP Gateway 
clients require an NDS® user login before connection is allowed.

Until a connection is made, all DNS lookups will fail because TCP/IP has been removed from the 
Name Provider list and has been replaced by the Gateway. Even a machine’s own HOSTS file will 
not be used.
Automatic Workstation Import 9
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The result is that a workstation registration for a Gateway client will fail because user login did 
not occur.

Action: Do not import Gateway clients using a Workstation Import policy that is configured without user 
information. Instead, for Gateway clients, configure the Workstation Import policy so that user 
login will need to occur.

In Remote Management, the IPX address of the target workstation is not registering properly with NDS
Explanation: The Novell® ClientTM workstation registration uses an API to obtain IPXTM addresses, which are 

unreliable in an IP-only environment. Because other ZfD features require pure IP (such as 
Workstation Imaging and Automatic Workstation Import), and because Remote Control relies on 
the network address information in the Workstation object’s properties, we recommend using IP 
for Remote Management.

Action: Do not install ZfD in an IPX-only environment. Use IP when performing Remote Management.

Automatic Workstation Import does not work immediately after installation of ZfD
Problem: I installed ZfD from a Windows 95/98 workstation to an NDS for NT server. Automatic 

Workstation Import would not immediately work.

Explanation: Windows 95/98 does not support the APIs used to install or start a remote service. 

Note that this problem does not exist if you install from a Windows NT/2000 client or to a 
NetWare® server.

Action: To install to an NDS for NT server, use a Windows NT or Windows 2000 workstation.

If you must install to an NDS for NT server using a Windows 95/98 workstation, reboot the server 
twice to get the import or removal service to run (once to finish the installation and once to start 
the service).

Computer name changes are not being updated in the Workstation object
Problem: If the computer name of a machine is used as part of the NDS workstation name in the Workstation 

Import policy, changes on the machine to the computer name are not automatically updated in the 
Workstation object’s name. This will cause workstation registration to use an incorrect computer 
name to register the workstation.

However, the Workstation object that did not get its name updated will still be a valid object for 
ZfD. All ZfD components will still be able to access and use that object.

Possible Cause: Windows deals with computer names in a way that causes this problem. Consider the following 
scenario:

An image is placed on a machine so that the computer name and Workstation object name in 
the image are not the same as the computer name and Workstation object name stored in the 
image-safe data.

The machine is booted and the image-safe data agent runs. This includes a call into Windows 
to set the computer name to the name stored in the image-safe data, if a computer name was 
stored there. This also restores the Workstation object information into the registry. If no 
Workstation object is found in the image-safe data, then the Workstation object information 
in the registry is deleted.

The Workstation Registration agent runs. If the Workstation object in the registry is 
nonexistent, or if the agent cannot find the Workstation object in the tree, then the agent will 
request a new Workstation object from the Workstation Import server.
10   ZENworks for Desktops 3.2 Troubleshooting Guide
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This leaves the tree with two Workstation objects for the workstation—one that it recognizes (the 
newer object) and one that is still valid to ZfD but is now orphaned.

Explanation: Some background on the two agents will explain why this scenario causes a problem. ZfD imaging 
delivers the image-safe data agent (ZISWIN.EXE) back to the Windows environment to facilitate 
the restoration of some vital configuration information following imaging operations. Another 
purpose of the agent is to pre-configure new machines with IP, workgroup, and computer name 
information.

Properly installed, ZISWIN.EXE runs during the Windows start-up process, but does not run early 
enough in the process that it can change the computer name of the machine before Windows reads 
and caches that name in memory. Therefore, although ZISWIN.EXE has changed the computer 
name, until the machine is rebooted any request to Windows for the computer name will return the 
older name.

The Workstation Registration agent is a component of the Workstation Manager Scheduler, which 
runs as an NT service. The Scheduler is loaded shortly after ZISWIN.EXE has run. In the case 
where ZISWIN.EXE has changed the computer name, when the registration agent runs and asks 
Windows for the computer name, Windows gives the agent the older name.

In the scenario where the computer already has a workstation object, or in the case where the 
computer name is not part of the name specified by the Workstation Import policy, then this should 
not cause any problems.

However, if this computer does not yet have a Workstation object and the Workstation Import 
policy specifies that the computer name should be used as part of the Workstation object’s name, 
the import process will create a Workstation object using the older computer name. This could 
quickly become confusing in ConsoleOne® when all workstations would have similar names with 
only the MAC address to distinguish between them.

Action: There are two possible actions:

Browse for the Workstation object in ConsoleOne and rename it to its original name. The ZfD 
workstation registration process guarantees that the workstation will be able to find itself in 
the tree after it has been renamed.

After a machine has booted with the new computer name effective:

1) Run UNREG32.EXE on the workstation to erase the machine’s knowledge of its NDS 
Workstation object.

2) Determine the current Workstation object for that machine > browse for the object > delete 
the object.
Alternatively, you could use the Automatic Workstation Removal policy to automatically 
remove the orphaned workstation at a scheduled time.

3) Re-register the workstation using one of the following methods:

Run WSREG32.EXE on the workstation

Reboot the workstation

Allow the Workstation Manager Scheduler to re-register the workstation at its scheduled 
time

This will cause the workstation to be associated with only one valid Workstation object and 
not leave an orphaned Workstation object in the tree.
Automatic Workstation Import 11
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2 Workstation Management

This section contains information about the following:

“Troubleshooting Workstation Management” on page 13

Troubleshooting Workstation Management
The following sections provide troubleshooting information for ZENworks® for Desktops (ZfD) 
Workstation Management:

“Installation errors occurred, such as the password not being set for the Inventory Service 
object” on page 13

“The Client Config policy does not work” on page 13

Installation errors occurred, such as the password not being set for the Inventory Service object
Problem: After installing ZfD, some of the following errors may occur:

The message "Unable to set password ... inventory installation skipped" was displayed in the 
installation summary

The public key attribute was not created in the Inventory Service object

Explanation: Object creation errors can occur if an outdated Novell® ClientTM is running on the workstation that 
is used to perform the ZfD installation.

Action: To install ZfD, only use a workstation that is running the client that was shipped on the ZENworks 
for Desktops Companion CD (or later).

The Client Config policy does not work
Problem: The Client Config policy will not push down when the default package impersonation is set to 

Interactive User.

Explanation: The Client Config policy only works when it is set to System Impersonation.
Workstation Management 13
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3 Workstation Imaging

The following section provides solutions to problems you might encounter when using 
ZENworks® for Desktops (ZfD) Workstation Imaging services.

“Troubleshooting Workstation Imaging” on page 15

Troubleshooting Workstation Imaging
The following sections provide solutions to specific problems you might encounter when using 
ZfD Workstation Imaging services.

“General Troubleshooting Tips” on page 16

“Image Is Created on or Restored from the Wrong Server” on page 16

“Image Is Restored to the Wrong Partition” on page 17

“Workstation Reboots After Imaging and Hangs with "LI" on the Screen” on page 17

“Near-Duplicate Workstation Object Is Created After Imaging” on page 17

“Image Doesn’t Fill the Entire Hard Disk” on page 18

“Can’t Boot a Workstation from the Imaging CD” on page 18

“Error Installing Imaging (Linux) Partition from Diskettes” on page 18

“Input/Output Error Installing Imaging (Linux) Partition from CD” on page 19

“Errors on Boot About a util.s File Missing or "modprobe:...."” on page 19

“"Kernel Panic" Error When Booting a Toshiba Laptop” on page 19

“Can’t Boot a Workstation from the Imaging Diskettes” on page 19

“Workstation Doesn’t Boot with the Requested Keyboard Language” on page 19

“Workstation Reboots Continuously” on page 20

“Can’t Launch the Imaging Boot Disk Creator (ZIMGBOOT.EXE) Utility from ConsoleOne” 
on page 20

“How Do I Exit the Linux Screen Saver Without Disturbing My Imaging Operation?” on page 
20

“I Need to Create a ZfD Imaging Partition Larger than 2 GB” on page 20

“I Need to Clear the Image-Safe Data from a Workstation” on page 20

“The Linux Partition on a Workstation Will Not Pick Up Imaging Jobs from the Imaging 
Proxy Server” on page 21

“Booting a Workstation Using an Imaging Boot Floppy or Bootable CD Fails to Pick Up 
Imaging Jobs from the Imaging Proxy Server” on page 21
Workstation Imaging 15
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“Windows 2000 Workstation Only Boots to Linux Partition, Not to Operating System” on 
page 21

“The Disable ZEN Partition and the Enable ZEN Partition Options from the PXE Menu Do 
Not Work” on page 21

“I Changed the IP Address of My PXE Server and Now I Can’t Boot a Workstation Using 
PXE” on page 21

General Troubleshooting Tips
Explanation: If you get an error when using a ZfD imaging server to perform an imaging operation, first try the 

action below. 

Action: Check the bottom of the Imaging Server Log (ZIMGLOG.XML) file for information on the 
imaging operation that you just performed. This file is explained in Imaging Utilities and Options 
in Workstation Imaging in Administration.

Explanation: If the problem has something to do with resolution of your imaging policies in NDS® and you 
aren’t sure what hardware data has been detected on your computer and used in policy resolution, 
try either of the actions below.

Action: Boot the computer with a ZfD imaging device in manual mode and type img info at the Linux* 
prompt. This shows the hardware data that was detected for your computer.

Action: Retry the auto-imaging operation from the Linux prompt by typing img auto. This displays 
messages explaining what the imaging engine is actually doing in the process.

Explanation: If the above actions don’t solve your problem, try the actions below.

Action: Check the specific troubleshooting sections that follow in this documentation.

Action: Check the Imaging Error Messages section in Error Messages.

Action: Check the ZENworks Cool Solutions (http://www.novell.com/coolsolutions/zenworks/) Web site. 
Additional troubleshooting tools and information are posted there from time to time.

Image Is Created on or Restored from the Wrong Server
Possible Cause: When performing a manual imaging operation, you might have specified two different imaging 

servers on the command line. Creating or restoring an image from one server by contacting another 
(referring) server is supported only in auto-imaging mode (by NDS policy), not in manual 
(command-line) mode.

For example, if XYZ_SERVER is at 137.65.95.127 and ABC_SERVER is at 137.65.95.126, then 
the following operation will not work as expected:

img mp 137.65.95.126 //xyz_server/sys/imgs/dellnt4.zmg

Rather than creating the image on XYZ_SERVER, this creates the image on ABC_SERVER if the 
/sys/imgs path exists on that server. If the path doesn’t exist, you get an invalid path error.

Action: Specify the same server in both the address parameter and in the filepath parameter. For example, 
in the scenario above, to create the image on XYZ_SERVER, you must issue the following 
command: 

img mp 137.65.95.127 //xyz_server/sys/imgs/dellnt4.zmg
16   ZENworks for Desktops 3.2 Troubleshooting Guide
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Image Is Restored to the Wrong Partition
Explanation: By default, the ZfD imaging engine restores an image to the lowest available partition slot number 

that has sufficient space to receive the image. 

Action: To ensure that an image (or a particular part of an image) is restored to a specific partition slot 
number, use the optional a:p parameter on the img restore command. For details, see Restore 
Mode in Imaging Engine (img: Command Line and Menu) in Imaging Utilities and Options in 
Workstation Imaging in Administration.

Workstation Reboots After Imaging and Hangs with "LI" on the Screen
Explanation: If you have made an image from a workstation that has a ZfD imaging partition, and then put down 

the image on a workstation that does not have a ZfD imaging partition, the wrong MBR (Master 
Boot Record) is restored and the workstation will hang with "LI" on the screen.

Action: To avoid having this occur, when imaging workstations without ZfD imaging partitions, make sure 
the image you create is made from a workstation that also does not have a ZfD imaging partition. 
Complete the following steps to correct the problem:

1 Boot the workstation using imaging boot diskettes or an imaging boot CD.

2 Enter lilo at the boot prompt.

or

1 Access a bash prompt.

2 If it is PXE-enabled, boot the workstation from the PXE server. Make sure to hold down the 
left Alt and Shift keys during the PXE boot to get the PXE menu. The menu must not be 
disabled on the server. (See the General PXE Settings property page for the Workstation or 
Server Imaging policy in ConsoleOne®.)

3 Select to start in Maintenance Mode from the PXE menu.

4 Enter lilo.s.

Near-Duplicate Workstation Object Is Created After Imaging
Explanation: If you are using ZfD Automatic Workstation Import or Workstation Management to register 

workstations as Workstation objects in your NDS tree and you use the default naming process for 
creating the Workstation objects (Computer name plus MAC address), you might see a near-
duplicate Workstation object name created for a workstation after it has received a new image.

Possible Cause: The reason for this is that the workstation is being registered using the Computer name that is 
embedded in the new image that was just laid down. The imaging agent does restore the original 
Computer name (or a new, policy-defined Computer name if the workstation is brand new) to the 
workstation’s registry. However, because Windows caches the Computer name before the imaging 
agent runs, and because the Workstation Manager agent runs shortly after the imaging agent runs, 
Workstation Manager queries Windows for the Computer name and gets back the Computer name 
that Windows has cached, which is the one embedded in the image that was just laid down. This 
results in the workstation being registered in NDS as a Workstation object with the same Computer 
name as the workstation from which the image was taken, but with a different MAC address.

Action: There is currently no automatic fix for this problem. You can manually rename the Workstation 
object in ConsoleOne (this won’t cause any problems), or you can delete the new Workstation 
object and let another one be created automatically later (when the changes made by the imaging 
agent have been propagated to Windows).
Workstation Imaging 17
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Image Doesn’t Fill the Entire Hard Disk
Explanation: When you take an image of a smaller hard disk and lay it down on a larger hard disk, by default 

the extra space on the larger hard disk is left unpartitioned.

Action: To work around this problem, when laying down the image, do it manually (from the Linux 
command line) and use the optional a:p parameter as the last argument. This parameter is 
described in Imaging Engine (img: Command Line and Menu) in Imaging Utilities and Options in 
Workstation Imaging in Administration. You can’t do this in auto-imaging mode.

1 Boot the target computer with an imaging device and enter manual at the boot prompt when 
the initial menu appears. Insert the second and third diskette if you are prompted for it.

2 At the Linux prompt, type img dump to see the current partitions.

3 Remove all the partitions using the img pd command.

For example, to remove partition 1, type img pd1.

4 Create and activate the new (empty) partitions needed to hold the new image that you will lay 
down. Use the img pc and img pa commands.

For example, to create and activate a single NTFS partition of the entire hard disk, type img 
pc1 ntfs followed by img pa1.

5 Lay down the new (smaller) image using the img r command with the a:p parameter.

For example, if the new (smaller) image is stored on an imaging server and it contains only 
one partition, you could fill the entire NTFS partition on the workstation with the smaller 
image as follows:

img rp 137.65.95.127 //imgsrv/sys/img/small.zmg a1:p1

6 After the image has been laid down, remove the boot device if needed, type lilo.s, and 
reboot the workstation.

Can’t Boot a Workstation from the Imaging CD
Possible Cause: The workstation that you are trying to boot might have a CD drive that doesn’t support 

multisession CDs. The ZfD imaging CD is a multisession CD because adding the 
SETTINGS.TXT file (and any other files) to the CD makes it so.

Action: The workstation must have a CD drive that supports multisession CDs. In our testing, we 
successfully booted an HP* Vectra VL, a Compaq* Prosignia*, and a Dell* Optiplex*, but some 
other workstations failed, including an IBM* PC 300PL, a Dell Dimension XPS T450, and an IBM 
clone with an Intel* motherboard. If you can’t use a CD as the imaging boot device, use diskettes.

Possible Cause: Some older workstations and clones are unable to boot with the imaging CD.

Action: If you can’t use a CD as the imaging boot device, use diskettes.

Error Installing Imaging (Linux) Partition from Diskettes
Possible Cause: You might have proceeded without inserting the proper diskette when prompted.

Action: Reinstall the Linux partition, making sure to pay careful attention to which diskette is being asked 
for at the prompts. For step-by-step instructions, see Enabling a Workstation for Unattended 
Imaging Operations in Testing Basic Imaging Operations in Workstation Imaging in Getting 
Started.
18   ZENworks for Desktops 3.2 Troubleshooting Guide
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Input/Output Error Installing Imaging (Linux) Partition from CD
Explanation: Certain input/output errors can appear when creating the Linux partition if you boot the 

workstation from a ZfD imaging CD. Examples of the error messages include:

/bin/cp: /bin/loadkeys: Input/output error/bin/cp: /bin/gunzip: Input/output 
error

Action: No action is required. You can ignore these error messages, because the Linux partition is still 
created successfully.

Errors on Boot About a util.s File Missing or "modprobe:...."
Explanation: If a workstation has a ZEN imaging (Linux) partition from a prior release of ZENworks, after the 

first boot the ZEN partition will be updated with a new imaging engine. From then on, warning 
messages may appear during the ZEN partition boot regarding a "util.s" file missing as well as 
"modprobe:..."

Action: No action is required. These messages are harmless and will not affect the way Imaging operates.

These messages should not occur if you are upgrading from ZfD 3 SP1.

"Kernel Panic" Error When Booting a Toshiba Laptop
Explanation: A compatibility problem exists between the Toshiba Satellite 2800-S201 laptop and the Linux 

kernel used by ZfD Imaging 3.2. The problem may be with the BIOS version in the PC. Although 
not reported, the problem may exist with other machines using a similar BIOS.

This problem only appears when the Linux kernel is started through a PXE session. Notebooks that 
do not have a built in network adapter cannot boot PXE and will not see the problem.

On these laptops, the Linux kernel will issue a "kernel panic" error message and halt the system. 
The error message that will appear on the workstation is: "Unable to handle kernel paging request 
at virtual address c4801000....Kernel panic: Attempted to kill init!"

Action: Disable the PXE boot option in the BIOS options of the laptop and instead use imaging boot 
diskettes, an imaging bootable CD or install a Zen imaging (Linux) partition carry out imaging 
operations on the laptop.

Can’t Boot a Workstation from the Imaging Diskettes
Possible Cause: The workstation that you are trying to boot might have a USB diskette drive, which is not 

supported.

Action: There is no workaround for this problem at present. The workstation must have a supported drive 
to be booted from the imaging diskettes.

Workstation Doesn’t Boot with the Requested Keyboard Language
Possible Cause: If your imaging boot device is configured to boot with support for a non-English keyboard and to 

allow manual rebooting of the workstation after imaging, when you use the boot device to install 
the imaging (Linux) partition on a workstation, the keyboard language support isn’t loaded until 
you manually reboot the workstation.

Action: Manually reboot the workstation. The correct language support should load for the keyboard.
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Workstation Reboots Continuously
Possible Cause: The last base image that was laid down on the workstation might be corrupt or might have become 

corrupt during download from the network.

Action: Boot the workstation from the ZfD imaging diskettes or CD and try laying down the image again. 
If this doesn’t work, retake the image and try laying it down again.

Can’t Launch the Imaging Boot Disk Creator (ZIMGBOOT.EXE) Utility from ConsoleOne
Possible Cause: You might be running ConsoleOne from a local installation or from a server that doesn’t have the 

ZfD Imaging software installed.

Action: Run ConsoleOne from a ZfD imaging server, or copy the ZIMGBOOT.EXE file from the imaging 
server (ZENWORKS\IMAGING) to a folder that’s in your Windows PATH.

Action: Add the path to ZIMGBOOT.EXE onto the system path and restart ConsoleOne.

How Do I Exit the Linux Screen Saver Without Disturbing My Imaging Operation?
Explanation: After about five minutes without user input, Linux enters a screen-saving mode where the screen 

goes blank.

Action: Press Ctrl, Shift, or Alt to exit the screen saver without disturbing your current imaging operation.

I Need to Create a ZfD Imaging Partition Larger than 2 GB
Explanation: When you create imaging boot diskettes using the Imaging Boot Disk Creator (ZIMGBOOT.EXE) 

utility, the largest size you can specify for the ZfD imaging (Linux) partition is 2 GB (2048 MB).

Action: After creating the imaging boot diskettes, edit the SETTINGS.TXT file on the third diskette and 
increase the value of the PARTITIONSIZE parameter as needed. For example, the following sets 
it to 4 GB (4096 MB):

PARTITIONSIZE=4096

I Need to Clear the Image-Safe Data from a Workstation
Explanation: You might need to do this for any number of reasons, such as if the image-safe area gets corrupted 

or populated with the wrong data (from an NDS policy, for example), or if you register the 
workstation as a different object in NDS.

Action: To clear the image-safe data, you need to enter a certain key in the Windows registry and reboot 
the workstation. Here’s one way to do this:

1 Use a text editor to create a file with the following contents:

REGEDIT4[HKEY_LOCAL_MACHINE\SOFTWARE\Novell\ZENworks]

"ZISWIN Clear"="1"

2 Save the file.

3 Run the file you just created by double-clicking it. 

This enters the above key in the Windows registry.

4 Reboot the workstation.

This causes the ZfD imaging agent to run, and in so doing to clear out the workstation’s image-
safe data.
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The Linux Partition on a Workstation Will Not Pick Up Imaging Jobs from the Imaging Proxy Server
Explanation: If you have already installed ZfD 3 imaging and you have a Linux partition on a workstation, the 

partition fails to pick up an imaging job from an imaging proxy server that has been updated to 
ZfD 3 SP1. 

Action: As soon as the Linux partition contacts the proxy server, it is automatically updated. The update is 
accomplished with two reboots. After a complete update, the imaging jobs will be picked up by 
the Linux partition.

Update files on an NT imaging proxy server updated to SP1 are located in 
NDS_for_NT_directory\ZENWORKS\IMAGING\UPDATE.

Update files on a NetWare® imaging proxy server updated to SP1 are located in 
SYS\ZENWORKS\IMAGING\UPDATE.

Booting a Workstation Using an Imaging Boot Floppy or Bootable CD Fails to Pick Up Imaging Jobs 
from the Imaging Proxy Server

Explanation: The imaging boot diskettes or imaging bootable CD will fail to pick up an imaging job if they have 
not been updated to the latest version of ZfD that is installed on the proxy server.

Action: Use a boot diskette or a bootable CD that has been updated to the version of ZfD that is installed 
on the imaging proxy server.

Windows 2000 Workstation Only Boots to Linux Partition, Not to Operating System
Explanation: Upgrading a Windows 2000 workstation hard disk from a Basic Disk System to a Dynamic Disk 

System changes the partition table so that it does not does not allow the workstation to boot to the 
production partition, only to the ZfD Linux partition. No fixes for this issue are included in ZfD 
3.2.

The Disable ZEN Partition and the Enable ZEN Partition Options from the PXE Menu Do Not Work
Action: If these options on the PXE menu do not work, access them by using the imaging boot diskettes 

or imaging CDs. You can also specify to disable the ZEN partition in ConsoleOne as part of the 
Imaging Server Policy or Workstation Imaging Policy.

I Changed the IP Address of My PXE Server and Now I Can’t Boot a Workstation Using PXE
Problem: A NetWare 5.1 server, functioning as the PXE server, has a set IP address. The IP address is 

changed using AUTOEXEC.NCF and the server is rebooted. After this change, a workstation that 
used to boot to PXE is no longer able to do so.

Action: Open PDHCP.INI and set the PDHCP_SERVER_IP entry to the new IP address of the server.
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4 Remote Management

The following section provides solutions to problems you might encounter when using 
ZENworks® for Desktops (ZfD) Remote Management services:

“Troubleshooting Remote Management” on page 23

Troubleshooting Remote Management
This section provides information to help you troubleshoot the following Remote Management 
problems:

“Refreshing the Viewing window” on page 23

“Remote Management does not work if imported workstation name includes extended 
characters” on page 23

“After installing the Remote Management Agent, the performance driver conflicts with the 
video driver installed on the managed workstation.” on page 24

“If JAWS is installed on the management console, ConsoleOne hangs on initiating or 
terminating some of the Remote Management sessions.” on page 24

“During a remote control session on a Windows 2000 workstation, it is sometimes difficult to 
move the managed workstation’s mouse or the mouse pointer might jump.” on page 24

“On Windows 2000 Professional, the Application Log in the Event Viewer logs errors for 
every Remote Control and Remote View session.” on page 24

Refreshing the Viewing window 
Explanation: The Viewing window may not update the screen to reflect the current state of the managed 

workstation when it is running certain Java* applications.

Action: Use the Refresh Screen accelerator key sequence, (Ctrl+Alt+R, by default) to refresh the Viewing 
window.

Action: Disable the acceleration driver by renaming DRISHTI.DLL, located in the  
Operating_System_Driver\WINNT\SYSTEM32 directory. Restart the machine.
IMPORTANT: Disable the acceleration driver only when the target workstation runs many Java/Swing 
applications during a Remote Control session.

Remote Management does not work if imported workstation name includes extended characters
Explanation: Some Remote Management operations will not be available on workstations where users have 

chosen to use extended characters in the computer name of their workstations and you, 
subsequently, use the computer name as part of the name for the imported workstation object.

Action: Do not use extended characters in a computer name.
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Action: Do not use the computer name as a part of the imported workstation object name.

After installing the Remote Management Agent, the performance driver conflicts with the video driver 
installed on the managed workstation.

Explanation: The performance drivers ensure that utilization is low when the Remote Management Agent is 
running on Windows* 95/98 and Windows NT*/2000 workstations. But certain video drivers can 
be incompatible with the performance enhancement driver and may cause Windows to crash.

Action: Rename the following files to disable the performance enhancement drivers:

On Windows 95/98, rename HOOK32.DLL, located in the Operating_System_Driver 
\NOVELL\ZENRC directory.

On Windows NT/2000, rename DRISHTI.DLL, located in the Operating_System_Driver 
\WINNT\SYSTEM32 directory.

This avoids loading the performance enhancement driver on reboot.
NOTE: Remote Management installation detects some of the video drivers that were found to have conflicts 
during testing and skips installing them. 

Action: Ensure that the performance enhancement driver has been installed on the managed workstation.

1 Right-click the Remote Management icon from the taskbar.

2 Click Information > the General tab.

The Optimization option will be enabled if the driver is installed.

If JAWS is installed on the management console, ConsoleOne hangs on initiating or terminating some 
of the Remote Management sessions.

Explanation: If JAWS* is installed on the management console, ConsoleOne® hangs if you start or terminate 
the following Remote Management sessions: File Transfer, Chat, Remote Execute, Ping, 
Diagnostics and Remote Wake Up.

Action: Change the screen display color settings to 65536 (16 bit) colors or greater and restart ConsoleOne.

To change the screen display color settings:

1 From the desktop console, click Start > Settings > Control Panel > double-click Display > 
click the Settings tab.

2 Select 65536 (16 bit) colors or greater from the Color Palette drop-down list.

During a remote control session on a Windows 2000 workstation, it is sometimes difficult to move the 
managed workstation’s mouse or the mouse pointer might jump.

Action: Increase the speed of the mouse cursor.

1 Click Start > Settings > Control Panel > double-click Mouse > click the Motion tab.

2 Increase the pointer speed.

On Windows 2000 Professional, the Application Log in the Event Viewer logs errors for every Remote 
Control and Remote View session.

Explanation: On Windows 2000 Professional, for every Remote Control and Remote View session, the 
Application Log in the Event Viewer logs the following error if the NwLink NetBIOS protocol is 
disabled:
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"The Open Procedure for service NwlnkNb in DLL \WINNT\System32\perfctrs.dll failed.  
Performance data for this service will not be available. Status code  returned is data DWORD 0."

Action: Enable the NwLink NetBIOS protocol or disable Performance Counters for NwInkNb. 

To disable the Performance Counters for NwInkNb, use the Performance Counter List utility 
(EXCTRLST.EXE) from the Windows 2000 Professional resource kit.
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5 Workstation Inventory

This section covers the following:

Troubleshooting Inventory installation problems

“Using JAVA.NLM” on page 28
“In the database, there are workstations with multiple MAC/IP/IPX/DNS addresses” on page 

30
“Is the installation of Workstation Inventory successful?” on page 30
“Is the database installed properly on the database server?” on page 30

Troubleshooting Inventory database problems

“Sybase displays messages for tables that do not have primary keys or have keys that are not 
indexed” on page 31

“Unable to start the database. Displays "Assertion failed" message” on page 31

Troubleshooting Inventory Service Manager problems

“Inventory Service Manager exits with -1 status” on page 31
“Inventory Service Manager exits with -3 status” on page 32
“Inventory roll-up does not happen as scheduled in the Roll-Up Scheduler” on page 32

Troubleshooting Inventory scanning problems

“Workstation Inventory does not show up in the Workstation Scheduler” on page 32
“Unable to launch the scanner on the workstation” on page 32
“Unable to load the Inventory Services on the server” on page 32
“Unable to scan Windows 95/98 workstations that are attached to a Windows NT/2000 

server” on page 33
“At times, the server utilization may reach up to 100%” on page 33
“The ZfD 3.2 SP1 Inventory server deletes the .STR files and triggers a full scan. The 

following message is displayed: "Could not process .STR_filename due to a non-Integer 
insertion for CIM_class_name.attribute_name"” on page 33

Troubleshooting display and query of Inventory information

“Different Last Scan Date display in Minimal Information page and Query Results window” 
on page 33

“Saved inventory queries for Database Export and Inventory Query do not work” on page 34
“Inventory data is not stored for Windows NT/2000 workstations with a null MAC address 

(000000000000)” on page 34

Troubleshooting Inventory report problems 

“Inventory reports designed for landscape mode do not print properly” on page 35

Troubleshooting Inventory in an existing ZfD setup
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“After installing ZfD 3.2 in an existing ZfD setup, the Service Manager does not work” on 
page 35

“After installing ZfD 3.2 in an existing ZfD setup, the Storer is unable to store the data in the 
Inventory database” on page 35

“After installing ZfD 3.2 in an existing ZfD setup, the DBExport Configuration files (.EXP 
and .CFG) with IRQ Number attributes cannot be used” on page 36

“After installing ZfD 3.2 in an existing ZfD setup, the DBExport Configuration files (.EXP 
and .CFG) that were created in ConsoleOne 1.2c6 cannot be used in ConsoleOne 1.2d” on 
page 36

“After installing ZfD 3.2 in an existing ZfD setup, the Inventory Database Export tool does 
not function properly” on page 36

“At the time of installing ZfD 3.2 in an existing ZfD setup, the scanner does not complete the 
scanning process or the scanner crashes on a Windows/NetWare Server” on page 36

“After installing ZfD 3.2 in an existing ZfD setup, Mouse, Serial Port, and Parallel Port data 
of a workstation in an Oracle database are not correctly reported” on page 37

Troubleshooting XML status report problems

“Unable to view the inventory status reports (XML format) in languages other than English” 
on page 35

Troubleshooting Workstation Inventory

Using JAVA.NLM 
Explanation: If you have installed JVM 1.2.2 with a JAVA.NLM version dated later than January 4, 2001, you 

should modify the .NCF files that ZENworks® for Desktops (ZfD) 3.2 uses.

Action: After you complete the ZfD 3.2 installation, follow these instructions:

1 Delete the following entries in the SYS:\SYSTEM\NAMING.NCF file: 

java -classpath $tmppath;$CLASSPATH
com.novell.orb.service.naming.NamingServer

2 Add the following entries in the SYS:\SYSTEM\NAMING.NCF file:

java -Xbootclasspath/p:$corbapath -classpath $tmppath;$CLASSPATH 
com.novell.orb.service.
naming.NamingServer

3 Delete the following entries in the SYS:\SYSTEM\STARTINV.NCF file: 

java -DConfigFile=sys:\public\zenworks\wminv\
properties\Config.properties -nsac -jszenWSInv
-neh -mx128m -classpath $tmppath;$classpath 
com.novell.zenworks.desktop.inventory.
servercommon.ZENWorksInventoryServiceManager

4 Add the following entries in the SYS:\SYSTEM\STARTINV.NCF file:

java -Xbootclasspath/p:$corbapath -DConfigFile
=sys:\public\zenworks\wminv\properties\Config.
properties -nsac -jszenWSInv -neh -mx128m -classpath 
$tmppath;$classpath com.novell.
zenworks.desktop.inventory.servercommon.ZENWorksInventoryService
Manager
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5 Delete the following entries in the SYS:\SYSTEM\LISTSER.NCF file: 

java -ns -neh -classpath $tmppath;$CLASSPATH 
com.novell.zenworks.desktop.inventory
.servercommon.ZENWorksInventoryListService "*"

6 Add the following entries in the SYS:\SYSTEM\LISTSER.NCF file:

java -Xbootclasspath/p:$corbapath -ns -neh -classpath 
$tmppath;$CLASSPATH 
com.novell.zenworks.desktop.inventory.servercommon.ZENWorksInven
toryListService "*"

7 Delete the following entries in the SYS:\SYSTEM\STARTSER.NCF file: 

java -neh -classpath $tmppath;$CLASSPATH 
com.novell.zenworks.desktop.inventory.servercommon.ZENWorksInven
toryStartService %1 %2 %3

8 Add the following entries in the SYS:\SYSTEM\STARTSER.NCF file:

java -Xbootclasspath/p:$corbapath -neh -classpath 
$tmppath;$CLASSPATH 
com.novell.zenworks.desktop.inventory.servercommon.ZENWorksInven
toryStartService %1 %2 %3

9 Delete the following entries in the SYS:\SYSTEM\ALTERDBSPACE.NCF file: 

java -nsac -neh -DDBUTIL=true -DMgrName=AlterDBSpace -
DMgrPropName=AlterDBSpace.properties -mx64M -ss256k -classpath 
$tmppath;$CLASSPATH 
com.novell.utility.servicemanager.ServiceLoader

10 Add the following entries in the SYS:\SYSTEM\ALTERDBSPACE.NCF file:

java -Xbootclasspath/p:$corbapath -nsac -neh -DDBUTIL=true -
DMgrName=AlterDBSpace -DMgrPropName=AlterDBSpace.properties -
mx64M -ss256k -classpath $tmppath;$CLASSPATH 
com.novell.utility.servicemanager.ServiceLoader

11 Delete the following entries in the SYS:\SYSTEM\ZEN2REMOVE.NCF file: 

java -nsac -neh -DDBUTIL=true -DMgrName=zen2Remove -
DMgrPropName=zen2Remove.properties -mx64M -ss256k -classpath 
$tmppath;$CLASSPATH 
com.novell.utility.servicemanager.ServiceLoader

12 Add the following entries in the SYS:\SYSTEM\ZEN2REMOVE.NCF file:

java -Xbootclasspath/p:$corbapath -nsac -neh -DDBUTIL=true -
DMgrName=zen2Remove -DMgrPropName=zen2Remove.properties -mx64M -
ss256k -classpath $tmppath;$CLASSPATH 
com.novell.utility.servicemanager.ServiceLoader

13 Delete the following entries in the SYS:\SYSTEM\DROPZEN2.NCF file: 

java -ns -classpath $tmppath;$classpath 
com.novell.zenworks.desktop.inventory.dbutilities.RemoveZEN2 
127.0.0.1

14 Add the following entries in the SYS:\SYSTEM\DROPZEN2.NCF file:
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java -Xbootclasspath/p:$corbapath -ns -classpath 
$tmppath;$classpath com.novell.zenworks.desktop.
inventory.dbutilities.RemoveZEN2 127.0.0.1

15 Delete the following entries in the SYS:\SYSTEM\STOPSER.NCF file: 

java -neh -classpath $tmppath;$CLASSPATH 
com.novell.zenworks.desktop.inventory.servercommon.ZENWorksInven
toryStopService %1 %2 %3

16 Add the following entries in the SYS:\SYSTEM\STOPSER.NCF file:

java -Xbootclasspath/p:$corbapath -neh -classpath 
$tmppath;$CLASSPATH 
com.novell.zenworks.desktop.inventory.servercommon.ZENWorksInven
toryStopService %1 %2 %3

In the database, there are workstations with multiple MAC/IP/IPX/DNS addresses
Explanation: While deploying Workstation Inventory, a top-down approach has not been followed. 

For example, you may have installed Inventory on the lowermost-level server (such as the Leaf 
Server) and then on the topmost-level server (Root Server). Then the Inventory Upgrade Service 
updates the database and, if required, corrects the anomalies in the database at the Leaf Server. 
However, at the Root Server, the old scan data of these workstations will exist along with the new 
data.

Action: At the higher-level servers, query the database for all workstations that have multiple addresses. 
Trigger a full scan for these workstations.

Is the installation of Workstation Inventory successful?
Action: Ensure that there were no errors after file copy during the installation.

Action: Ensure that the Inventory Service object is created. In Novell® eDirectoryTM, check to see if the 
container of the NCP Server object contains the Inventory Service object (ZenInvservice).

Action: Ensure that the Scan directory (SCANDIR) is created on the server.

Is the database installed properly on the database server?
Action: On a NetWare® server, ensure that the database startup screen is displayed on the server.

Action: On a Windows* NT*/2000 server, ensure that the Sybase* service is shown in the list of services.

Out of memory problems
Explanation: When the Inventory database maintained in Oracle* is mounted on NetWare and Windows NT and 

Windows 2000 servers, and the Out of Memory message is displayed, there is insufficient memory 
to run the inventory schema. 

Action: We recommend a minimum of 256 MB RAM at the Root Server.

If the memory problems are not resolved, fine-tune the variables in the INIT.ORA file located in 
the ZENWORKS\DATABASE directory on the server. The file contains the following memory 
structure sizing variables:

SHARED_POOL_SIZE

DB_BLOCK_BUFFERS
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LOG_BUFFERS

Reduce the SHARED_POOL_SIZE value and increase the value of the other variables. Down and 
restart the server using the MGMTDBO.NCF or the MGMTDBO.BAT file.

If the Inventory database is in Sybase on NetWare servers, modify the parameters in the 
MGMTDBS.NCF file. For more information about the parameter values, see Sybase Database 
Startup Parameters in Workstation Inventory in Administration.

Sybase displays messages for tables that do not have primary keys or have keys that are not indexed
Explanation: These messages indicate that accessing certain tables may result in performance degradation. 

Action: Ignore these messages while using ZfD because these tables are not accessed. 

Unable to start the database. Displays "Assertion failed" message
Possible Cause: The database was up at the time of a database server abend.

Possible Cause: The database server was switched off without shutting down the database.

Action: Restore the database using a recent backup. For more information, see Backing Up the Inventory 
Database (Sybase) in Workstation Inventory in Administration.

Action: If you do not have a database backup copy or the database copy cannot be restored, follow these 
instructions:

1 Make a backup of the MGMTDBS.NCF file located in the SYS:\SYSTEM directory.

2 Modify the MGMTDBS.NCF file. 

2a Insert the -f parameter after the DBSRV7 parameter.

2b Delete the path to other databases, such as NAL.DB. Do not delete the MGMTDB path.

2c Save the changes.

3 Stop the database. At the database server on the NetWare server, type q.

If the database is not unloaded, type unload dbsrv7.

4 Rename the MGMTDB.LOG transaction log file in the ZENWORKS\DATABASE directory.

5 Load the database. 

At the database server console, type mgmtdbs.ncf

The database will start in recovery mode, displaying the messages "Recovery complete" and 
"Database server stopped".

6 Delete the existing MGMTDBS.NCF and rename the backup copy of the file to 
MGMTDBS.NCF.

7 Load the database. 

At the database server console, type mgmtdbs.ncf.

Inventory Service Manager exits with -1 status
Explanation: The Service Manager displays -1 status if the Roll-Up policy or the Database Location policy is 

not set up or if the policies are not configured properly. These errors can also occur if the Service 
Manager is unable to authenticate to the Inventory Service object, Intermediate Server, or the 
Database object. 
Workstation Inventory 31



Novell Confidential 07_ts_zdfs_wsinven.fm last saved  5/16/ Manual Version: 3/17/03103
Action: See the detailed explanation of these errors in Service Manager Error Messages in Workstation 
Inventory Error Messages in Error Messages.

Inventory Service Manager exits with -3 status
Explanation: The Service Manager displays -3 status if ORB is not installed correctly, or some other application 

has overwritten the path or the classpath to a different ORB.

Action: Install ORB from the ZfD 3.2 Companion CD. Restart the Inventory services.

Inventory roll-up does not happen as scheduled in the Roll-Up Scheduler
Explanation: Modifications to the Roll-Up schedule were made while the Inventory services were loaded.

Action: If you are modifying the Roll-Up schedule, always stop the Inventory services, configure the 
schedule for roll-up, then restart the Inventory services again. 

Workstation Inventory does not show up in the Workstation Scheduler
Action: Do the following:

1. Check whether the correct Novell ClientTM is installed on the workstation.

2. Check whether the workstation is imported properly. From the desktop menu, right-click the 
Workstation Manager > Display NDS Information. The Workstation object and the tree 
should be displayed. Alternatively, verify by using the registry Key: HKEY-local 
machine\software\novell\\workstation manager\identification.

3. Check whether the Inventory policies are configured and associated to the workstation or to 
the container of the workstation.

4. After importing the workstation, if the scanner cannot be launched, restart the workstation.

Unable to launch the scanner on the workstation
Action: Do the following:

1. Ensure that the root of the tree on which you have installed Workstation Inventory is trustee 
of the SYS:\PUBLIC directory of the inventory server on NetWare servers. On Windows NT/
2000 servers, ensure that the SYS Share directory exists.

2. Check whether the Inventory policies are configured and associated to the workstation or to 
the container of the workstation.

3. Check whether the scan is scheduled in the Workstation Inventory Scheduler.

4. Check whether the ZENWORKS directory on the SYS: volume is shared and that users 
(Everyone users) have special access for Windows NT/2000 servers.

5. On NetWare servers, the PUBLIC\ZENWORKS directory should have Create rights.

Unable to load the Inventory Services on the server
Action: Ensure that the Inventory policies are configured for the server, based on the role of the server. See 

Configuring Servers for Workstation Inventory in Workstation Inventory in Deployment.

Action: Ensure that the database is up and running on the database server.

Action: After configuring the policies, ensure that you wait a sufficient time for the objects to synchronize. 
In a tree with a large number of objects and partitions, this may take some time.
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Unable to scan Windows 95/98 workstations that are attached to a Windows NT/2000 server
Action: If you have configured a Windows NT/2000 as the Inventory server and there are Windows 95/98 

workstations that will send their scan data to that Windows NT/2000 server, you must do the 
following for the scanners to collect data:

If there are eDirectory users who are also Windows NT/2000 Domain Users, ensure that the 
users logged in are valid users of the Windows NT/2000 domain in the existing Share created 
by ZfD.

If there are users logged in to a different domain, ensure that the users are Trusted users of the 
domain in the existing Share created by ZfD.

If there are eDirectory users who are not users of any Windows NT/2000 domain, ensure that 
the users do not log in to eDirectory during workstation startup. However, these users can log 
in to eDirectory later.

If there are users who do not log in to any Windows NT/2000 domain, or in to eDirectory, but 
these users log in to their local workstations with a username and password, ensure that the 
user name and password are also part of the Windows NT/2000 domain.

At times, the server utilization may reach up to 100%
Possible Cause: The server is processing a large number of scan files to be stored in the Inventory database.

Possible Cause: The server sends huge compressed scan files (.ZIP files) across the WAN link.

Possible Cause: The server is generating reports for a large number of workstations.

Explanation: Processing the scan files and sending huge .ZIP files across WAN link happens only during the 
initial phase of inventory deployment. Report generation is done at a very low frequency, maybe 
once in a quarter or a year, The administrator should be aware of this high utilization.

The ZfD 3.2 SP1 Inventory server deletes the .STR files and triggers a full scan. The following message 
is displayed: "Could not process .STR_filename due to a non-Integer insertion for 
CIM_class_name.attribute_name"

Explanation: You might encounter this error for any attribute of a CIM class such as CIM.Processor.Family.

Possible Cause: The .STR file is for a Windows 98 (and not Windows 98 SE) workstation, which has the default 
version of WMI installed. The default version of WMI is not compatible with ZfD 3.2 SP1.

Action: You can update to correct WMI version by downloading Microsoft’s Windows Management 
Instrumentation - Core Software Installation from Microsoft WMI Web site (http://
msdn.microsoft.com/downloads/default.asp?url=/downloads/sample.asp?url=/msdn-files/027/
001/576/msdncompositedoc.xml).
NOTE: To instrument a workstation for WMI, you need to download only the WMI Core Software Installation.

To troubleshoot any WMI-related problems, you can also download the WMI SDK.

Action: If you do not want to update WMI, you can disable WMI scanning.

On the Inventory server, edit the PUBLIC\ZENWORKS\SCANSOURCE.INI file to set the value 
of doWMIScan=FALSE.

Different Last Scan Date display in Minimal Information page and Query Results window
Explanation: The last scan date reflects the time of the scan in the minimal information stored in the NDS 

Workstation object. This information is also displayed while querying the inventory database from 
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ConsoleOne®. It is possible that the database update is in process while the minimal information 
in the Workstation object is already updated.

Saved inventory queries for Database Export and Inventory Query do not work
Explanation: Mouse.IRQ, Serial.Port.IRQ, and Parallel Port.IRQ have been changed to Mouse.IRQ Number, 

Serial.Port.IRQ Number, and Parallel Port.IRQ Number.

Action: Regenerate the queries and save.

Inventory data is not stored for Windows NT/2000 workstations with a null MAC address 
(000000000000)

Problem: If the inventory scanner reports a null MAC address (000000000000)for Windows NT/2000 
workstations, the inventory data is not stored for those workstations.

Workstation Inventory identifies workstations based on the their MAC addresses. The inventory 
of the workstations is not stored if there are duplicate MAC addresses. It is also possible that 
inventory data of one workstation will be overwritten by some other workstation scan data. Also, 
the Inventory Summary will not display any inventory data for the workstation.

Action: Ensure that you have installed ZfD3.2.

Follow these steps:

1 Stop the Inventory service and database:

On NetWare servers, at the inventory server prompt, enter java -killall

On Windows NT/2000 servers, stop the ZENworks Inventory Service.

2 Disable scanning of workstations. In ConsoleOne, invoke the Inventory Service object 
property page, then uncheck the Enable Scan of Workstation check box.

3 Delete the scan data files (.STR and .ZIP) from the SYS:\ZENWORKS\SCANDIR and 
SYS:\ZENWORKS\SCANDIR\TEMP directories.

4 Make these changes:

For a Sybase database, copy the database files (MGMTDB.DB, MGMTDB1.DB, 
MGMTDB2.DB, MGMTDB3.DB, MGMTDB4.DB, MGMTDB5.DB, MGMTDB6.DB, 
MGMTDB7.DB, MGMTDB8.DB, and MGMTDB9.DB) from ZfD 3.2 Program CD to 
the \ZENWORKS\DATABASE directory.

For an Oracle database, follow the instructions in Configuring the Inventory Database for 
Oracle in Deployment.

5 Enable scanning of workstations. 

5a In ConsoleOne, right-click the Inventory Service object (servername_ZenInvservice) > 
click Properties > click the Inventory Service Object Properties tab. 

5b Click Enable Scan of Workstations.

5c Click Full Scan.

6 Start the Inventory services.

To run the Inventory Services on a NetWare server: at the server prompt, enter startinv.

On a Windows NT/2000 server, start the Inventory Service Manager (ZENworks Inventory 
Service). 

Verify the inventory information in the Workstation Inventory Summary window.    
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NOTE: To resolve the null address problem with workstations for ZfD3 Support Pack 1, refer to the Technical 
Information Document at the Novell Support web site (http://www.support.novell.com). 

Inventory reports designed for landscape mode do not print properly
Explanation: The following inventory reports do not print properly from ConsoleOne 1.2c:

General Workstation Inventory Report

Asset Management Report

Hardware Inventory Report

Networking Information Report

Software Inventory Report

Software Inventory Report for the Entire Site

To print these reports, you must export the report to an Adobe Acrobat* .PDF file (click File > 
Export Report > Export as PDF). In the Adobe Acrobat Reader, open the .PDF file and print the 
report, making sure that print orientation is set to Landscape mode.

Unable to view the inventory status reports (XML format) in languages other than English
Explanation: To view the status of the inventory components, open the INVENTORYLOG.XML status log file 

in any third-party XML browser. 

If there are no browsers that support viewing XML documents in languages other than English, 
create a comma separated value (.CSV) file and view the .CSV in any third-party CSV viewer such 
as Microsoft* Excel. The CSV file will have the same contents as the INVENTORYLOG.XML 
file.

Action: To create the .CSV file:

1 Edit the INVENTORYXMLLOG.INI file located on the inventory server 
(SYS:\PUBLIC\ZENWORKS\WMINV\LOG).

1a Insert the following parameter in the file: WRITE_TO_TEXT_FILE

2 Save the changes.

3 Restart the inventory server.

View the .CSV file to ensure that the file contains the status logs for the inventory components.

After installing ZfD 3.2 in an existing ZfD setup, the Service Manager does not work
Explanation: Before the SP1 inventory roll-out was complete on all servers, there were modifications to the 

existing inventory deployment or changes in the setup such as a change of role for the server or 
installation of a database on the server.

Action: Before making any changes in the Inventory setup, ensure that inventory     roll-out is complete on 
all servers.

After installing ZfD 3.2 in an existing ZfD setup, the Storer is unable to store the data in the Inventory 
database

Explanation: The Inventory Upgrade Service has not been run.

Action: Restart the Inventory services.
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After installing ZfD 3.2 in an existing ZfD setup, the DBExport Configuration files (.EXP and .CFG) with 
IRQ Number attributes cannot be used

Explanation: Mouse.IRQ, Serial.Port.IRQ, and Parallel Port.IRQ have been changed to Mouse.IRQ Number, 
Serial.Port.IRQ Number, and Parallel Port.IRQ Number. The configuration files that contain these 
attributes will not work after SP1 is installed.

Action: Create the configuration files, save the files, and run the Data Export tool.

After installing ZfD 3.2 in an existing ZfD setup, the DBExport Configuration files (.EXP and .CFG) that 
were created in ConsoleOne 1.2c6 cannot be used in ConsoleOne 1.2d

Explanation: Workstation Inventory supports ConsoleOne 1.2d. The configuration files created in ConsoleOne 
1.2c6 do not work in ConsoleOne 1.2d.

Action: In ConsoleOne 1.2d, create the configuration files, save the files, and run the Data Export tool.

After installing ZfD 3.2 in an existing ZfD setup, the Inventory Database Export tool does not function 
properly

Explanation: The Inventory Upgrade Service has not been run.

Action: Restart the Inventory services. Run the Data Export tool again.

At the time of installing ZfD 3.2 in an existing ZfD setup, the scanner does not complete the scanning 
process or the scanner crashes on a Windows/NetWare Server

Action: Clear the server connection to the scanner.

Follow these steps on a NetWare server:

1 From the server prompt, run MONITOR.NLM.

2 From the File Open/Lock activity > Select an entry.

3 Locate the \PUBLIC\ZENWORKS directory that contains the NTSCAN32.EXE. Select the 
NTSCAN32.EXE file > press Enter.

4 Check the connection number for the file.

5 In Options > Connections, select the particular connection > press the Delete key to clear the 
connection > click Yes.

6 Repeat the steps to clear the connection for WINSCAN.EXE.

Follow these steps on a Windows NT server:

1 From the Administrative Tools > click Server Manager.

2 From View > Servers, double-click the server > click Properties > Sessions > click In Use.

3 Select the following files:

NTSCAN32.EXE
WINSCAN.EXE
LOC32VC.DLL
ZENPOL32.DLL

4 Click Close Resources.

Follow these steps on a Windows 2000 server:

1 Click Administrative Tools > Computer Management > Shared Folder > Open Files.
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2 Right-click the NTSCAN32.EXE Scanner file > click Disconnect.

3 Repeat step 2 for other files (WINSCAN.EXE, LOC32VC.DLL, and ZENPOL32.DLL) and 
disconnect the open files.

After installing ZfD 3.2 in an existing ZfD setup, Mouse, Serial Port, and Parallel Port data of a 
workstation in an Oracle database are not correctly reported

Explanation: While deploying Workstation Inventory, a top-down approach has not been followed. 

For example, you may have installed Inventory on the lowermost-level server (such as the Leaf 
Server), and then on the topmost-level server (Root Server). Then the Inventory Upgrade Service 
updates the database and, if required, corrects the anomalies in the database at the Leaf Server. 
However, at the Root Server, the old scan data of these workstations will exist along with the new 
data. 

Action: At the higher-level servers, query the database for all workstations which do not have the 
Inventory attributes (Mouse, Serial Port, and Parallel Port). Trigger a full scan for these 
workstations.
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A Documentation Updates

This section lists updates to the Troubleshooting guide that have been made since the initial release 
of Novell® ZENworks® for Desktops (ZfD) 3.2. The information will help you to keep current on 
documentation updates and, in some cases, software updates (such as a Support Pack release).

The information is grouped according to the date when the Troubleshooting guide was updated and 
republished:

October 31, 2002 (ZfD 3.2 Support Pack 1)

October 31, 2002 (ZfD 3.2 Support Pack 1)

Location Update

“The ZfD 3.2 SP1 Inventory 
server deletes the .STR files 
and triggers a full scan. The 
following message is 
displayed: "Could not process 
.STR_filename due to a non-
Integer insertion for 
CIM_class_name.attribute_na
me"” on page 33

Added a new troubleshooting scenario to provide guidance to ZfD 3.2 
Support Pack 1 (SP1) users because the default version of WMI is not 
compatible with ZfD 3.2 SP1.
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